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Notices 

 The reproduction, transmission or use of this document or its contents is not permitted 

without express written authority.  

 Information and specifications in this document are subject to change without notice. 

 While information in this document is well edited and checked, mistake or omission may 

exist. Please don’t hesitate to contact SUPCON if you have any question about this 

document.  

 Please contact SUPCON via email “SMS@supcon.com” if you have any question. 

 

Trademarks 

Trademarks or marks SUPCON, SPlant, Webfield, ESP-iSYS, MultiF, InScan, SupField are all 

registered, registering or using by Zhejiang SUPCON Technology Co., Ltd., which owns the 

properties of all trademarks or marks above. Without the written authority from Zhejiang 

SUPCON Technology Co., Ltd, no individual or company shall use any trademarks or marks 

above. We reserve the right to take legal action for any individual or company using trademarks 

or marks above illegally. 

 

Symbol Definition 

 

WARNING: Indicates information that a potentially hazardous situation which, if not 

avoided, could result in serious injury or death. 

 

RISK OF ELECTRICAL SHOCK: Indicates information that Potential shock hazard 

where HAZARDOUS LIVE voltages greater than 30V RMS, 42.4V peak, or 60V DC 

may be accessible. 

 

ESD HAZARD: Indicates information that Danger of an electro-static discharge to 

which equipment may be sensitive. Observe precautions for handling electrostatic 

sensitive devices 

 
ATTENTION: Identifies information that requires special consideration. 

 
TIP: Identifies advice or hints for the user. 
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VFFBDBuilder 

Section 1 Overview 

VFFBDBuilder is one of the most important control strategy configuration tools in control system. It 

provides functions of FBD programming and debug. 

1.1 Software Features 

Control software conforms to IEC61131-3 standard. By combining with function block library, it 

provides powerful functions of FBD user program editing and debug, and supports single program 

compiling and online download. 

FBD software supports configuration of the initial values of function block parameters, online 

parameter download and editing, displayed or non-displayed input/output pin settings, function 

block parameter settings as displayed input/out pin, user-defined function block execution order, 

debug technology based on truncated information flow, activation and close down. 

1.2 Function Features 

 Initial values of function block parameters can be configured; 

 The input/ output pin of function block can be set to displayed or invisible; function 

block parameters can be displayed as input/ output pins; 

 The execution sequence of function block can be determined by users; 

 Implement the redundancy and multicast of function block data automatically; 

 Support online modification of function block data in user program; 

 Provide online debugging and support activation and close down of function block’s 

input and output; 

 The HMI properties (display decimal digits, etc.) of function block’s tag can be 

configured. 

 Modify the basic properties (description, tag level and tag group) of function block 

tag in batch. 
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Section 2 Configuration Steps 

Configuration steps are as follows: 

Select the Control Station Needs to Add Custom Program 
and Open It from Configuration Server

FBD Programming 

Create New FBD Custom Program and Open the 
VFFBDBuilder

Add Datalink

Set Referenced Tag

Connect Lines, Set Special Line and Ordnary Line

Set the Execution Sequence of Function Block 
(Selectable)

Compile Passed

Return to A 
Certain Link 
Above for 

Modification 
According to the 

Prompt

Add Function Block

Set Parameters of 
Function Block

Compile Failed

End

Debug Passed

Download

Online Debug

Compile

Return to A 
Certain Link 
Above for 

Modification 
According to the 

Prompt

Debug Failed

 

Figure 2-1 Graphics of FBD Custom Program 
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Section 3 Create/ Import a New FBD Program 

User can create a new FBD program in VFExplorer, or import one as CSV file. Different controller 

types support different number of programs. FCU711-S and FCU712-S controllers support up to 

200 pages of user programs, and FCU713-S controller supports up to 500 pages of user programs, 

and FCU714-S controller supports up to 1000 pages of user programs. 

3.1 Create a New FBD Program 

Open the Configuration Management Software. Select corresponding controller in the 

configuration tree on the left of interface. Click “Open” from menu of “Control Scheme”, or click 

button  on the tool bar, a dialog box “New Custom Program” pops up, as shown in Figure 3-1. 

 

Figure 3-1 Dialog box of “New Custom Program” 

Click “OK” after input the name and descriptions to create a new FBD custom program, as shown 

in Figure 3-1. 
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Figure 3-2 Interface of Configuration Management Software 

Double click the new program to open editing interface. 

3.2 Configure FBD Program Properties 

3.2.1 Set FBD Program Properties 

Users can set the phase and period of FBD program. Phase and period will affect the running time 

of the custom program. 

1) Select any program and then right click it, select “Property”  and the custom program property 

dialog box pops up as shown in the figure below. 

 

Figure 3-3 Dialog box of program property setting (the left graph shows FCU712-S and the right graph 
shows FCU711-S) 

1. Configure the basic properties according to the table below. 

Configuration 
Item 

Configuration Description 

Name 
A string of no more than 64 English characters or 32 Chinese characters, only begin with a letter 
and be letters, numbers and underscores, it cannot be duplicated (the system also cannot be 
duplicated function blocks) . 
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Configuration 
Item 

Configuration Description 

Description A string of no more than 128 English characters or 64 Chinese characters. 

Cycle 

FCU711-S、FCU712-S、FCU713-S和FCU714-S supports fast cycle, 1 times, 2 times, 5 times and 
10 times. FCU811-S supports fast cycle and 1 times. 
When the cycle of the user program is “fast cycle”, the fast scan cycle of the controller is used to 
execute the user program, and the phase configuration is not supported. 

Starting phase 

Setting the starting phase is a function set for distributing the program running load of the 
controller in each phase. After downloading, each program cyclically runs according to the set 
initial phase. 
FCU711-S、FCU712-S、FCU713-S 和 FCU714-S supports the option of 0~9 as the initial phase. 
FCU811-S only support 0 as the initial phase. 

Priority 
When the user programs have the same starting phase, the controller will determine the user 
program to be executed first according to the priority. 

 

3.2.2 Set FBD Program Password 

Follow steps below to set password for FBD program: 

1. Right-click an FBD program, and select “New Password” and the dialog below pops up. 

 

Figure 3-4 Create Password 

2. Input the password and confirm it in boxes “Password” and “Confirm Password”. 

3. Click “OK” to save the password of FBD program. 

The icon of FBD program with password will be , and pop up the following dialog when opening 

FBD program. 

 

Figure 3-5 Validate Password 
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3.3 Import FBD Program as CSV File 

The folder “\data\FBDTemplate” in installation directory includes 2 FBD program module as 

CSV files. 

 CSV file with the postfix “loop” is single loop or cascade loop FBD program applying PID 

and PIDEX function blocks. 

 CSV file with the postfix “motor” is valve FBD program applying DIO21V, DIO01V, 

DIO11V, DIO22V, DIO11M, DIO21M, Motor, Valve function blocks. 

3.3.1 Operation Steps 

Operation steps to import CSV file: 

1. Right “Custom Program” and select “Generate Program in Batch”. 

2. In the “Open” dialog, select a CSV file and set "Csv Files For FBDImportTemplate 

(*.csv)" as the "files of type" and click “Open”. 

FBD program will be created automatically in the right pane after importing FBD program 

successfully, as shown below. The top 2 are FBD programs created by CSV file with the 

postfix “motor”. 

 

Figure 3-6 FBD programs created after importing CSV file 

3.3.2 CSV File 

This part takes “FBDImportTemplate_loop.csv” as an example to introduce the contents in 

CSV file. 

 

Figure 3-7 Example of CSV file 

As shown in the figure above, CSV file includes 4 FBD programs, “Single Loop (1)”, “Single 

Loop (2)”, “Cascade Loop (1)” and “Cascade Loop (2)”. 

Meanings of each field in CSV file are shown in Table 3-1. 

Table 3-1 Instruction for FBD program imported file as CSV 

Field Instruction 

FBDIMPORTTYPE Refer to that the table is FBD import program 

PROGRAMNAME Program name, correspond to the created FBD custom program 

PROGRAMDES Program description 

LOOPTYPE Loop type 

TYPE Function block type 
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Field Instruction 

NAME Function block tag name 

DESC Function block description 

INPUT Input pin of function block 

OUTPUT Output pin of function block 

TAGGROUP Tag group of function block 

SVSCL~SWPN Pin information of function block 

 

 Tip: 

For the detailed configuration, please refer to “Function Block“. 

 

3.3.3 Notes 

Notes when importing FBD custom program as CSV: 

 If importing the custom program has already existed in configuration, and prompt of 

program name repeat will show in output bar, and prompt whether to continue. Click 

“Yes” to skip importing the repeat program and continue to import other programs. Detail 

import information will be shown in output bar. Select “No” to not import. 

 After importing CSV file, the FBD program created doesn’t be compiled automatically. 

 If the tag configured in archive doesn’t exist when importing, or is configuration 

parameter, create undefined data to connect normally. An error prompt will pop up for 

undefined data connection when compiling, which can pass until specify the data 

connection.  

 The template contents will be checked first before importing CSV file, import can be 

performed only after checking successfully. If failed, the import of the program will be 

skipped and go to check and import next program directly.  
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Section 4 Introductions to Edit Interface 

4.1 Main Interface 

Double-click existed FBD program in configuration management interface, FBD programming 

software interface will pop up, as shown in Figure 4-1. 

 

Figure 4-1 FBD programming builder 

 Title Bar---display program title. 

 Menu Bar---include five menus of file, edit, program, view and help, and each menu 

contains several submenus. 

 Toolbar--- lists frequently used menu function in the form of icon, making it 

convenient for users to operate. Click the menu View/Tool bar to decide whether to 

show the bar or not. 

 Edit Area---work area for program editing. 

 Function Block Library---display function blocks supported by current system, 
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including system function blocks, industry function blocks and user-defined function 

blocks. 

 Search Box--- Input the name of function block, then press “Enter”, the function 

block will be searched for. 

 Output Bar---display the information of compile, find and procedure record, users 

can get access to different information by selecting different label pages. “procedure 

records” displays all the operation information in editing area. Location by double 

click is supported. 

 Information Bar---display all function block information in editing area, and editing 

operation can be carried out to function blocks. Click “View” and select “Information 

Bar” to show/hide it. 

 Status Bar--- prompt user the function of the button when the mouse is on a menu 

command or an icon button in toolbar. Click “View” and select “Status Bar” to 

show/hide it. 

4.2 Introductions to Menu Bar& Toolbar 

Table 4-1 Instructions to menu function and toolbar 

Menu Submenu Icon Function  

Save Ctrl+S   Save current configuration 

Exit  Exit software 

Import  Import control configuration 

Export  Export control configuration 

Print Ctrl+P  Print active document 

Print Page Footer Settings  Set print footers 

Print Preview  Display full page 

Print Settings  Change printer or print settings 

File 

Diagram Settings  Change the diagram settings and print effect. 

Copy Ctrl+C  Copy selected function block or connection line 

Cut Ctrl+X  Cut selected function block or connection line 

Paste Ctrl+V  
Paste function block or connection copied or cut to edit 
area 

Delete  Delete selected function block or connection line 

Find/ Replace Ctrl+F  Find/ Replace current function block by name sequence 

Datalink Selectively quote a tag or variable 

ISCP datalink  Link other station variables 

Edit 

Select All  Ctrl+A  Select all objects 

Compile(B) F7  Compile programs 

Online(C) F5  Connect to controller 

Function Block Debug  Display/ Hide window of function block parameter debug 

Variable Debug  Display/ Hide window of variable debug 

Program  

Add to Debug List  Add tag to debug list 
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Menu Submenu Icon Function  

Save the Real-time Value of 
Function Block  Save the real-time value of function block parameter 

Activate All Input Parameters  Activate all input parameters 

Activate All Output Parameters  Activate all output parameters 

Function Block Auto Queue  Function block auto queue 

Function Block Library  Display/ Hide window of function block library 

Output Bar Display/ Hide Information Bar 

Toolbar  Display/ Hide toolbar 

Status Bar  Display/ Hide status bar 

Information Bar  Display/ Hide function block information bar 

Show/Hide Selected Frame  Show/Hide selected frame of logic diagram 

Tag Descriptions  Display/ Hide descriptions of all tags. 

Tag Hardware Addresses  
Display/ Hide addresses of all tags. Only when the tag is 
the channel tag, the address can be displayed. 

Initial Value of Function Block's 
Input Parameter  

 
Display/ Hide default value when the input pin of function 
block is not connected 

View 

Function Block's Config 
Parameter Initial Value 

 Display/ Hide part of pins or parameters of function block 

Help About  Display software information, version and copyright 

/  Zoom In. Zoom in current program view 

/  Zoom Out. Zoom out current program view 

/  Normal. Revert current program view to original view 

/  Annotation. Make editing in annotation status 

/  
Adjust Block Running Sequence. Adjust execution 
sequence 

  
Special Line. Set the specified line as Special Line in 
brown. Eliminate the circle.  

  
Normal Wire. Set the specified line as Ordinary Line, and 
it will included in auto queue 

  
Logic Diagram Select Frame. Select and drag to create a 
logic diagram select frame. 

/  Align Left. Align selected objects to the left 

/  Align Right. Align selected objects to the right 

/  Align Up. Align selected objects to the top 

/  Align Down. Align selected objects to the bottom 

/ 

/  Display currently quoted data of function block 

 

4.3 Introductions to Information Bar 

Information of all function blocks in current program is arrayed in execution sequence in 

information bar, making it convenient for users to quickly locate the function block for operation. 

Specific instructions to function of information bar are shown in Table 4-2. 
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Table 4-2 Instructions to function of information bar 

Operation item Function 

Double-click certain function block information Select corresponding function block and center it 

Right-click menu/ Modify function block 
Pop up corresponding property setting window of the function 
block 

Right-click menu/ Shift up/ Shift down 
Fine adjustment of the execution sequence. The corresponding 
function block shift step -1/ +1 

Ctrl+↑ Same as “Shift up” 

Ctrl+↓ Same as “Shift down” 

 

4.4 Introductions to Right-click Menu of Function Block/Tag 

Select a function block/tag in the work area and right-click it; a shortcut menu will pop up, varying 

according to selected objects. Specific instructions are shown in Table 4-3. 

Table 4-3 Instructions to right-click menu command of function block 

Menu item Function 

Basic Properties Properties settings for function block  

Parameter Settings Basic Parameter settings 

Copy Copy currently selected object 

Paste Copy object copied or cut to work area 

Delete Delete currently selected object 

Activate Input Activate current input 

Activate Output Activate current output 

View Logic View the logic of global function block 

Debug Logic Debug the logic of global function block 

Assign FF Tag Assign FF tag for current function block. 

Unassign Unassign FF tag 

 

Table 4-4 Instructions to right-click command of tag 

Menu item Function 

Select tag Select a tag 

Copy  Copy currently selected object 

Paste 
Copy object example copied or cut to work area: 
 Reserve tag name of function block when cutting. 
 Remove tag name of function block when copying. 

Delete Delete currently selected object 

Display descriptions Display tag descriptions 

Display address Display tag address  
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Section 5 Programming Instructions 

5.1 Data Type 

Table 5-1 System data type list 

Symbol Length (bit) Instructions 

BOOL 8 ON, OFF 

SINT 8 -128 ~ 127 

USINT 8 0~ 255 

INT 16 -32768 ~ 32767 

UINT 16 0~65535 

DINT 32 -2147483648~2147483647 

UDINT 32 0~4294967295 

REAL 32 Float value 

LREAL 64 Double-precision floating-point valueNote 1 

Note1: only controller FCU811-S supports LREAL. 

5.2 Basic Program Elements 

5.2.1 Datalink 

Datalink is used to connect data variables in FBD program. By selecting data type of the variable 

via datalink function and editing the quoted variable, it can be made in accordance with specific 

tag in tag configuration software. Datalink block in editing area is shown in Figure 5-1. 
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Figure 5-1 Datalink 

 Double-click “Datalink” or right-click “Datalink” and select “Tag Selection” in the 

pop-up right-click menu, pop up a dialog box of “CS Tag Selecting”. 

 After achieving tag reference, description display and hardware address display are 

available via “Display Description” & “Display Hardware Address” of the pop-up 

right-click menu, as shown in Figure 5-2. 

 

Figure 5-2 Display Description and Hardware Address 

5.2.2 General Function Block 

Function block is used to perform certain specific calculation function. In FBD program, function 

blocks can be classified into the following categories: control function block, logic control function 

block, analog processing function block, selection operation function block, arithmetic operation 

function block, logic operation function block, communication assistant function block, 

communication between stations function block, sequence control function block, industry function 

block, IO special processing function block, comparison function block, custom function block, etc. 

Function blocks of different types are separately stored in different function block libraries. Please 

refer to Function Block Manual for specific functions of each function block. 
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Function block example in editing area is shown in Figure 5-3. 

 

Figure 5-3 General Function block diagram example 

5.2.3 Global Function Block 

Global function block can be referenced in program of any control station. Please refer to the 

Config Explorer User Manual for details of global function block and how to create. 

The global function block created can be applied in VFFBDBuilder. Figure 5-4 shows the example 

of referencing global function block “G_AAA” in the custom program. 
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Figure 5-4 Example of global function block 
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Section 6 FBD Programming 

6.1 Datalink 

In the FBD program, you can add IO tag, custom variables and other datalinks, and you can also 

add array-type parameters of user function block. 

6.1.1 Add a Datalink 

When the controller is FCU711-S, FCU712-S, FCU713-S or FCU731-S, the FBD program in the 

controller can reads, writes and judges the tag in the control station through datalink. In the 

High-performanceHMI software, the datalink in the FBD supports hardware channel tag, custom 

tag and communication tag in the current control station. 

1) Select Tag 

Double-click Datalink or right click Datalink and select “Select Tag” in the right-click menu, 

select the tag to be added to Datalink in pop-up dialog box of control station tag selection, 

as shown in Figure 6-1 

 

Figure 6-1 Interface “control station tag selection” 

2) Select tag field. 

 Select by R/W property. 

When selecting a specific tag in tag selection box, users can have access to 

advanced parameter setting by clicking “View Parameter” button  of this tag. In the 

"Properties" column, "READONLY" means it cannot be accessed. 
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Figure 6-2 Tag parameter list 

 Select array-type parameter. 

When selecting array-type parameter, select the tag parameter (such as OUT1), 

and define its Index1 and Index2. 

 

Figure 6-3 Array-type parameter selection 

3) Click "OK" to finish adding, then the array parameter is displayed in the program in the 

format of "tag name.parameter name[index1, index2]". 

 

Figure 6-4 Array parameter displayed in user program 



VFFBDBuilder User Manual                                                   IM41S59-E 

18 

6.1.2 Add Cross-Station Datalink 

For control stations with FCU714-S controllers, the user program supports the tags in the current 

control station as well as other FCU714-S control stations. The available address types include 

hardware channel addresses and custom addresses. 

Prerequisites 

When a control station needs to reference data from other stations, the current station should be 

configured as the data receiver, while the data source station acts as the data sender: 

 In VFExplorer, select the current control station in the navigation tree and double click 

"Cross-system Station Communication" in the right area. Then add the address of the data 

source station in the dialog box that appears. 

 

 In the control station configuration of the data source station, select "Inter-system Station 

Communication" and add the data that can be sent from the data source station in the dialog 

box that appears, as shown in the diagram below. 

 

 

 

Tip:  

For detail configuration of Cross-System Station Communication，please refer to Config 

Explorer User Manual. 

 

Steps 

1) Select "Edit > Datalink" in the menu bar, click the programming area after the shape of 

the mouse changed to add datatlink to the program. 

2) Double click the datalink to bring up the "Tag Selection" dialog box as shown as below. 
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Figure 6-5 DataLink Supported Cross-Station Configure Example1 

 

3) Configure the datalink 

 On the "Tag Reference" tab, select the control domain, control station, and tag type 

where the tag is located. From the tag list, choose the desired tag. If the tag is within the 

current station, it is a local tag and it will be shown as . If the tag is 

a cross-station tag, it is a remote tag and it will be shown as . 

 Select "Addr Reference," which displays the address configuration as shown in the 

diagram below. In the "Reference > Name" or "Reference > Alias" text box, configure the 

content of the address reference. 

 

The name is used to specify the data type, station address, and domain address of the 

inter-station communication variable, in the format of "data type + index@station 

address.domain address." For example, in the control station shown in Figure [2.2], if a 

BOOL-type inter-station communication variable "ND02020000.VALUE" is added as a 

cross-station data reference to the user program, its reference name would be 

configured as "BOOL1@2.2". After adding it to the user program, the data reference is 

displayed as shown . 

The alias is used to specify the name by which the cross-station communication variable 
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is displayed in the user program. Aliases within the same control station cannot have the 

same name as other tags or aliases. 

 

Figure 6-6 DataLink Supported Cross-Station Configure Example2 

 

6.1.3 Add ISCP Datalink 

When the controller type is FCU811-S, the FBD user program in the control station supports 

reading the tag information of other stations communicating with the current control station through 

ISCP (Inter-Station Communication Protocol) datalink. 

Prerequisites 

Before adding the ISCP datalink, you need to configure the ISCP tag of the current control station. 

For details, please refer to VFConBuilder Software User Manual. 

Steps 

4) Select "Edit > ISCP Datalink" in the menu bar. 

5) Switch the shape of the mouse and click the programming area to bring up the "Tag 

Selection" dialog box. 
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6) According to the following table, configure the property of ISCP datalink. 

 Name shows the data type, station address and domain address of the inter-station 

communication variables, so its form should be "data type + serial number @ station 

address. domain address". As shown in the figure below, the BOOL-type 

inter-station communication variable "DI_SE0002000.PV" in the [0.2] control station 

is used as the ISCP data linked to the user program, and its reference name is 

"BOOL1@1.2". 

 Alias is the name of inter-station communication variable displayed in the user 

program. Aliases in the same control station cannot overlap with other tags or other 

aliases. 

7) Click "Add", the configured ISCP will be added to the list below, where all configured 

aliases of interstation tags are listed. 

8) Select the interstation communication tag and click "OK", the alias referenced by ISCP 

data will be displayed in the user program. 

6.1.4 Delete Datalink 

1. Click Delete in toolbar after selecting a single or several Datalinks in editing area; 

2. Click delete command in edit menu after selecting a single or several datalinks in editing area; 

3. Select delete command in the right-click menu after selecting single or several datalinks in 

editing area; 

4. Click Delete key after selecting a single or several datalinks in editing area; 

Methods above will all pop up confirmation box of delete and selected tag can be deleted after 

clicking “Yes”. 

6.1.5 Tag Update Prompt 

Relevant descriptions and address information of reference tag will be re-read when starting or 

compiling the program. 

If name or descriptions of reference tag are modified, update prompt will pop up when compiling or 

restarting the program, as shown in Figure 6-7. 
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Figure 6-7 Tag update prompt 

If the tag does not exist, tag update prompt will pop up to prompt user that the tag is not found, as 

shown in Figure 6-8 

 

Figure 6-8 Prompt of tag not found 

6.2 Function Block 

6.2.1 Data Preparing 

The function of naming the advanced function block is set to read its parameter information in 

Supervision conveniently. The named function block example can be displayed in the 

VFTAGBuilder by function block tag, as well as read in Supervision. 
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Name of function block tag cannot contain blank space. It can consist of letter, number, “_” and 

“-”.The tag name can contains 24 characters at most, and the description can contains 64 bytes at 

most. 

 

Figure 6-9 Naming the Function Block Example 

 

Tip:  

The name of function block must start with number or letter, and consist of letter, number, 

“_” and “-”. 

6.2.2 Add a function block 

Select the needed function block in function block library and move the mouse to editing area, click 

the mouse to create a function block example. The location of function block example can be 

adjusted by dragging it with mouse. Right click it in editing area to cancel the selected function 

block. 
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Figure 6-10 Function block library 

 

Tips: 

 Within a control station, only one type of SFC custom function blocks or Phase class 

function blocks is supported. If SFC custom function blocks are added, Phase class 

function blocks cannot be added. Similarly, if Phase class function blocks are added, 

SFC custom function blocks cannot be added again. 

 The maximal capacity of one FBD program and the maximal data are limited by the 

capabilities of each controller. Please plan accordingly based on the capabilities of the 

controllers. When FBD program is overrun it will prompt “Program capacity overrun”, 

and when data is overrun it will prompt “function block memory limit”. 

 To the new added or modified function block, the left of its type name will added symbol 

“*”. 

 The function block can be searched by inputting the keyword in the “Search Box”. The 

keyword can be part of the function block name or the description of the function block.

 

6.2.3 Basic Property Settings of Function Block 

Right-click function block and select item “Basic Properties” in the pop-up right-click menu, the 

dialog box of function block property setting will pop up. 

Function blocks are classified into advanced function blocks and simple function blocks. Advanced 

function block with the function of naming the function block tag can be read in Real-time 

Supervision Software via function block tag name, meanwhile, it has instrument panel and tuning 

panel; simple function block without the function of naming the function block tag doesn’t have 

instrument panel or tuning panel, and can’t be read in Real-time Supervision Software. 

Advanced function block 

The basic properties settings of advanced function block are shown in Figure 6-11. 
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Figure 6-11 Advanced function block properties settings 

 Set the tag name of function block 

Make sure that each tag has a unique name in the whole project and each function block 

example name has a unique name in the program. If there are function blocks having the 

same name in the program, a prompt box “There is function block named “XXX” in this 

program”. 

If there are function blocks have the same tag name within one control station, a prompt 

will pop up when being saved, as shown in Figure 6-12. 

 

Figure 6-12 Prompt “Tag name repeated in the station” 

If there are function blocks have the same tag name among the control stations, a 

prompt will pop up when being saved, as shown in Figure 6-13. 
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Figure 6-13 Prompt “There is a conflict when checking the tag names” 

 Set the input or output active/ inactive status  

Such as the status selected in Figure 6-11. 

When input and output are inactive, function block will do nothing to the sign of Inactive 

which instead will be responded by FBD program. When the input of a function block is 

inactive, all inputs remain the value of last period (namely, no input update); when the 

output of a function block is inactive, the function block will be executed normally and 

output, but its output won’t be sent to the input of its downstream function block (i.e., the 

input of downstream function block remains the value of last period). When in input and 

output are active, function block will be executed normally and output, and its output will 

be sent to the input of its downstream function block. 

Active/ Inactive statuses of function block input and output are shown in Figure 6-14, 

when input and output are inactive, each pin will be red in online debug status. 

 

Figure 6-14 Active and Inactive status 
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Attention: 

After function block is downloaded to main controller, its input and output can be forced to be 

in Inactive status by debug software. On this condition, users can set the forced value of 

function block’s input, debug its logic to make sure the correctness of its function. It should be 

used cautiously because it may do damage to current process status, and switch Inactive to 

Active may produce interference to output. Debug engineer should grasp the best time for 

switch. 

 

 Set the tag group 

Tags are divided into groups from 0 to 31. Select tag group from pull-down box, as 

shown in Figure 6-15. 

 

Figure 6-15 Select tag group 

 Set the tag level 

Tag degree has levels of 0~9 (level 0 is the highest and level 9 the lowest), select tag 

level from pull-down box, as shown in Figure 6-16. 

 

Figure 6-16 Tag level setting 

Tag level is used for distinguishing whether to pop up reconfirmation dialog box in 

supervision when the tag value is modified. Users can set a level for some important 

tags, then set this level as the one which needs reconfirmation in “Security” (“Need 

Confirm”) in System Builder Software. 
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 Set the decimal digits 

Decimal digits can be chosen from 1 to 7, select decimal digits from pull-down box, as 

shown in Figure 6-17. 

 

Figure 6-17 Decimal digits setting 

 

Tips： 

By default, function block has the same number of decimal places as the global default 

configuration. 

During the operation of copy and paste, function block has the same number of decimal 

places as the number of decimal places configured in the instance of original function 

block. 

 

 Set the panel 

Select the panel type, which is created when editing global function block and system 

function block, from the pull-down menu of “Panel”. 

Creating of the global function block and system function block refers to Config Explorer 

User Manual. 

 

Figure 6-18 Panel setting  

Simple function block 

The basic properties settings of simple function block are shown in Figure 6-19. 
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Figure 6-19 Interface of “Add Function Block Properties Settings” 

Only input and output status of function block can be set in “Function Block Properties” page, and 

specific setting procedure is the same as that of advanced function block. 

Global function block 

Properties settings dialog box of global function block is shown below. 
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Figure 6-20 Basic Properties Settings Dialog Box of Global Function Block 

Users can configure contents as below. 

 Name 

 Input Status/ Output Status 

 Description 

 Tag Group 

 Alarm 

 Tag Level 

 Decimal  

 Panel  

The configuration method is just like advanced function block. 

Besides, users can also set Panel and Macro. 

Panel setting of global function block is shown below. Users can select panel type for Custom 

Program in the pull-down menu. Panel types in the pull-down menu are the global function block 

panels created in VFExplorer. 
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Figure 6-21 Basic Properties Settings Dialog Box of Global Function Block (Panel Setting) 

Macro setting of global function block is shown below. Select “Macro” in the Properties Settings 

dialog box. 

 

Figure 6-22 Global Function Block Macro Settings Dialog Box 

Setting methods of panel and macro refer to Config Explorer User Manual 3.2.3 Configure 

Properties of Global Function Block. 

6.2.4 Parameter Settings 

Parameters are classified into basic parameter and extended parameter; they can be set in 
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window of “Function Block Properties Settings” and displayed in tree structure. 

 

Figure 6-23 General PID Function Block Properties Settings Dialog 

 

Initial Values and Pins 

 Initial values of function block parameters can be set on the basis of default values. As 

shown in the “Extended” tab in Figure 6-24. The initial value in the list means the value of 

each parameter when it is downloaded for the first time. 

In the figure below, when the parameter is of array type. Click "Settings" button in the 

"Initial Value" column. Configure the initial values in the pop-up window. 
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Figure 6-24 Array parameter initial value setting 

 Selected parameters will be displayed as the input/output pin in the FBD program. 

Alarm parameter setting 

There is an “Alarm Enable Settings” in the basic parameter settings of some function blocks, click 

“Settings” button in the “Initial Value” column, a dialog box of “Alarm Enable Settings” will pop up, 

as shown in Figure 6-25. 
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Figure 6-25Alarm enable settings 

Enable the alarm parameter and configure alarm priority in “Alarm Enable Settings” dialog, 

operation steps are shown below: 

1. Enable Alarm 

Select the check box of “Alarm Type” to enable. Select to enable and unselect to disable. 

Alarm can be enabled by batch enable and single enable: 

 Select the check box of “Alarm Type” to change it as enabled . Otherwise, it is 

disabled. 

 Click “Select” and select “Select All” in the pop up menu, to complete the batch settings 

for alarm parameter.  

 

Figure 6-26 Alarm Enable Settings 

2. Configure Alarm priority 

Select the alarm priority from drop-down menu of “Alarm priority”. 

3. Click “OK” to go back, and complete the alarm parameter settings of function block tag. 

 
Tip: 

Please make sure the alarm priority of HHH alarm is higher than HH alarm when 

configuring tag alarm value, otherwise compiling error will pop up. It is similar with alarm 

configuration and has same requirements. 

 

Basic parameter settings for other types 

The initial values of some parameters can be inputted manually, or selected in pull-down menu by 

clicking the pull-down button. For example, the selection of project unit, users can select needed 
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unit on pull-down menu by clicking the pull-down button in the initial value column, as shown in 

Figure 6-27. 

 

Figure 6-27 Project Unit Setting 

 

Tip: 

Initial value of function block example parameter is used as download initial value. 

Modified initial values can also serve as a basis for function block’s on-line download, and all 

parameter modifications will be recorded. 

 

Engineers can set basic parameter and extended parameter according to different requirements. 

6.2.5 Copy/ Paste Function Block and Wiring 

Edit can be easier by copying/ pasting function block and wiring. Effect of copy/ paste: 

 Paste the function block and wiring according to the copy source, the lines are totally 

same. 

 Create a new function block of “Copy Source Tag Name_ copy No.” (No. increases from 

1 according to the copy source, make sure there is no repeated tag name in project. As 

shown below, the copy source tag name is “gg”, and the pasted tag name is “gg_copy1”. 
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Figure 6-28 Copy and paste function block and wiring 

6.2.6 Set the Execution Sequence of Function Block 

Auto queue  

Users can order the function block execution sequence according to the data flow by auto queue, 

to ensure the execution sequence with logic correctness.  

The method of executing auto queue is clicking “Program” and selecting “Function Block Auto 

Queue” in “Menu Bar”. An ordinal number displayed in the bottom right corner, as shown below. 

 

Figure 6-29 Auto Queue 

There must have no loop in a paragraph in the Auto Queue mode. A loop refers to a function block 

can find itself through its output pin connection line. User can delete a certain connection line 

causing loop or set it as special line. 

Method of setting special line refers to “6.3.2 Set Special Line”. 

Manual queue 

Click “Program” and unselect “Function Block Auto Queue”, or click the icon  in Toolbar to 

activate the sequence setting. Then the serial number in the lower right corner will turn into blue, 

as shown below. Users can click function blocks one by one to change the execution sequence 

(after sequence rearrangement, click one function block and it get the greatest serial number, 

other function blocks get serial numbers less than it one by one). The function block execution 

sequence is set according to the sequence of creating function block examples in default. 
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When there are several function block examples and hard to adjust their execution sequence, 

users can press “Ctrl”, click a certain function block example to adjust it as the first of the execution 

sequence. Then drop “Ctrl” and adjust the execution sequence of other function block examples. 

Thus, the serial numbers of function blocks have been changed. For example, if users press “Ctrl” 

and select the function block whose serial number is 6, then the execution sequence will be 

started from 6. If the second function block clicked has a greater serial number, then its serial 

number becomes 7; if it is less, then its serial number becomes 6, and other function blocks get 

serial numbers less than 6 one by one. 

  

Figure 6-30 Function Block Program Execution Sequence 

6.2.7 ST Mix-Programming Function and Examples (Optional) 

FBD software supports ST language mix-programming function: call CALC from “Analog Process” 

and double-click the function block, dialog box of “Text Calculation Function Block Properties 

Settings” will pop up. Switch to “Content” page, as shown in Figure 6-32. Users can use ST 

language to write the inner logic of function block, making it convenient to carry out logic 

calculation and mathematical calculation. 
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Figure 6-31 Content 

CALC function block contains 4 REAL input and 1 REAL output by default, and can be extended to 

16 input pins including 8 REAL, 4 BOOL and 4 INT, and 13 output pins including 5 REAL, 4 BOOL 

and 4 INT, as shown in Figure 6-32. 
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Figure 6-32 CALC Function Block parameter 

When programming ST logic in CALC, users can only use these determinate input/ output pins 

instead of using tags and function blocks in system directly. 

Please refer to FBD Builder Software on ST language programming rule. 

For example, select REAL1 (input pin), REAL2 (input pin), BOOL1 (input pin), BOOL2 (input pin), 

REAL9 (output pin), and then input the logic shown in Figure 6-33, which relates each input/output 

pin to the practical tag. When the relevant tags of BOOL1 and BOOL2 are all on, the relevant tag 

of REAL9 equals that of REAL1, otherwise, it equals that of REAL2. 
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Figure 6-33 Text calculate function block 

6.2.8 Alias Parameters Settings of Function Block (Optional) 

When users need several custom function blocks with the same inner logic and different reference 

parameters (tags) not used as the parameters of input/output pins, then these parameters can be 

set as “alias variable”. The custom function block with alias variable needs to define tag example 

to alias variable in FBD Programming Software.   

To build the association between alias variable and actual tags. 

1. Select a custom function block with alias variable, open the dialog box of function block 

property setting and switch to “alias list” tab.  

2. Double click alias parameter editing box, users can define tag example to alias parameter by 

the pop-up tag selector, as shown in Figure 6-34. 

 Only alias parameters can be edited and modified. The selected actual tags’ data type 

must be consistent with alias variable of function blocks. When the alias type of function 

block is array, the actual tags of array type should be selected. 

 Custom function block with alias (variable) must correspond to the actual tags, otherwise, 

it cannot be compiled. 
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Figure 6-34 Editing interface of alias parameter of alias function block 

6.2.9 Invalid Function Block and Its Auto Upgrade (Optional) 

Invalid Function Block Introduction  

When starting the program, function block in current archive will be compared to configuration file 

of the function block, and if the version of the function block is obsolete (the function has already 

been upgraded), the function block will be displayed in yellow indicating this function block is 

invalid. 

 

Figure 6-35 Invalid function block diagram 

 

 

Tip: 

System prescribes that when invalid function block exists in current program, adding of 

function block examples won’t be allowed, and compile won’t pass. 

 

Auto Upgrade of Invalid Function Block 



VFFBDBuilder User Manual                                                   IM41S59-E 

42 

When starting the program, dialog box of “Invalid Function Block Auto-upgrade” will pop up if 

invalid function block exists in current program, and current invalid function block will be upgraded 

automatically after clicking “Yes”. If click “Cancel” now, users can also upgrade function block latter 

by “Auto Update” command in the right-click menu in editing area. The invalid function block can 

be auto updated while compiling in Configuration Explorer Software. 

 

Tips: 

 When upgrading function block, if pin parameter does not exist or parameter is modified 

(either parameter name or parameter data type), lines corresponding to the parameter 

will be deleted by system, therefore, program should be re-checked after auto-upgrade 

to guarantee correct logic. 

 When alias function block becomes non-alias function block, or non-alias function 

block becomes alias function block by adding an alias to this block, function blocks of 

this type can’t be upgraded automatically. 

 Auto-upgrade may change the address of function block. 

 When it is found by upgrade check that upgrade may cause any item of data area, 

multicast data area and redundancy data area off limit, upgrade will be unavailable. 

 

6.2.10 Set Display Mode of Function Block 

The programming software of FBD supports the display mode of function block as needed. 

 Display/ hide default values of input parameters 

Select View>Function Block Input Parameter Initial Value in the menu bar. If this 

configuration item is checked, the default value when the function block input pin is not 

connected is displayed. 

 Display/ hide some pins or parameters 

Select View>Function Block Configuration Parameter Initial Value in the menu bar. If 

the configuration item is checked, some pins or parameters of the function block are 

displayed. If the item is not checked, some pins or parameters of the function block will be 

hided. 

6.2.11 Create and Configure Logic Diagram 

Click the icon  “Logic Diagram Select Frame” in toolbar, press the left key of mouse and drag 

into a frame, in which the graphics will be generated automatically. 
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Figure 6-36 Logic Diagram Select Frame 

1. Several graph objects can be put in an FBD program. VFFBDBuilder can generate 

several logic diagrams according to the frame graph objects.  

2. The “Edit” box is in the lower right corner of frame. The name cannot be empty (and 

should conform to the naming rules of graphics), Frame names in the program page 

cannot repeat, cannot contain characters “\\/:*?\”<>|!@#$%^&=,.';[]+-~(){}`”. The length 

cannot exceed 24 characters. 

3. The graph object can be moved by selecting. User can select copy, paste, delete and 

properties settings by right-clicking the frame. The size of frame can be set in properties 

settings dialog, which cannot be less than pixel 200*400. 

4. Click the “Show/Hide Select Frame” button in toolbar to show or hide the select frame. 

Save the settings, so the select frame will be shown as set when open again. 

5. Right-click the select frame and select “Properties Settings” and the dialog below pops 

up. 



VFFBDBuilder User Manual                                                   IM41S59-E 

44 

 

Figure 6-37 Properties Settings 

Select a function block “PIDEP” in select frame, as shown below. 

 

Figure 6-38 Draw select frame 

In the real-time monitor, users can open this function block, click “Pop-up logic” button to view the 

logic shown in the selection box. If the logic contains data reference, it displays the real-time data 

according to the type of data reference. 

 If the data reference is normal tags, it normally displays the real-time value of tags. 

 If the data reference is data tags, it only displays the real-time values of array tags in this 

local control domain. The real-time values of array tags in the reference domain doesn’t 

be displayed. 
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6.3 Connection line 

6.3.1 Connect Function Blocks 

Lines between function blocks should come from output to input, users should first select the 

output of a function block (a blue box will appear around the output when it is selected) and keep 

the mouse button pressed until it is dragged to the input of another function block, and in this way, 

the line between output and input is created. 

6.3.2 Set Special Line 

Connection line can be set as special line in the mode of Auto Queue to eliminate the circle. When 

Auto Queue is executed, the special line will be ignored by the program.  

The method of setting special line: select the specified connection line and click the icon  in 

the Toolbar. The selected line will be brown (the line has been brown will not change), which 

means the line has been turned into special line. 

6.3.3 Set Ordinary Line 

Special line can be restored as ordinary line in the mode of Auto Queue, and then it will be 

included by the program when Auto Queue is executed.  

Special line can be restored to the ordinary line by the buttons in toolbar. Select the special line 

(displayed as brown) and select to restore it the ordinary line (displayed as black) . 

 

Tip: 

 Only the lines from output pin of upstream function block to input pin of downstream 

function block are allowed. 

 Software will check the consistency of data types of objects connected by the line 

automatically, and connection will not be allowed if data types are not consistent (line 

will become red in this case, normally it is blue). 

 When the line connected the BOOL data, the line will be the broken black line. 

 One output pin of function block can be connected to several input pins of other 

function blocks, but one input pin of function block can only be connected to one 

output pin of another function block. 

  

6.4 Compile  

 

Tip: 

Users can debug the function blocks with simulation controller when real controller is 
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absent or concerning of security. 

 

Compilation is used to check whether the reference tag exists, whether tag name conflicts exist on 

program page, and the compilation result will be displayed on output bar. 

A completed FBD program should be saved, compiled and downloaded before online debug. If the 

program passed compilation, but hasn’t been downloaded, prompt box will pop up after clicking 

“online” to prompt “Program need download”. 

If the compilation is not passed, the program can be saved, but cannot be downloaded. 

6.5 Online Debug 

After the compilation and download of FBD, click “Online” button in the toolbar for online debug, 

and “Program Debug”, “Function Block Debug”, “Variable Debug” and “Save the Real-time Value 

of Function Block” keys become enabled, in addition, option “activate all input parameters” and 

“activate all output parameters” will be enabled. 

Instructions to function keys are shown in Table 6-1. 

Table 6-1 Instruction list of function keys 

 Online 

 Program Debug 

 Function Block Debug 

 

 

Tip: 

Users can set input and output to Active or Inactive according to requirements when 

debugging. Users can select “Activate All Input Parameters” and “Activate All Output 

Parameters” in “Program”. 

 

6.5.1 Program Debug 

Click “Program Debug” button and the real-time value of each function block pin in program area 

will be displayed. If the user function block or global function block in the program area contains 

array parameters, the array parameters do not display real-time values. 
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Figure 6-39 Real-time value of function block pin 

As shown in the figure above, the real-time value of each pin of the PID function block is displayed 

in the program area. IN1 and OUT1 in G_SF are array-type parameters, so their real-time value is 

not displayed. If you need to view the real-time value of the parameter of this type of function block, 

you can click the “Set” button in the parameter real-time value column in the function block 

parameter debugging interface, and the real-time value of the array member will be displayed in 

the pop-up interface. 

In the debugging process, if the program didn’t run or the result wasn’t correct, the possible cause 

is the program has been shielded. You should check the status of the program for confirming 

whether or not it is shielded. For details, refer to “Online” section in VFExplorer User Manual. 

6.5.2 Function Block Debug 

Click “Function Block Debug” button, interface of function block parameter debug will pop up. 

Select any function block and the real-time data of all parameters of the function block will be 

displayed in debug bar, and modification on-line is allowed (except for configuration parameter). 
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Figure 6-40 Function block parameter debug 

If the control scheme would be changed if a parameter is modified in real-time status, the 

parameter is called configuration parameter. For example, Direct/Reverse action selection switch 

(SWPN), control output type (OUT_OPT) in PID function block, etc.  

 

Tips: 

For FF function block, parameter values in different status are in different colors. 

 Blue question mark refers to that the parameter status is uncertain. 

 Red cross refers to that the parameter status is bad. 

 Black refers to that the parameter status is good. 

 

6.5.3 Variable Debug 

Click “Variable Debug” button, variable debug column will pop up, as shown in Figure 6-41. 
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Figure 6-41 Variable debug bar 

Double click reference tags connected to each function block pin in debug status, the real-time 

value of corresponding tag will be displayed in variable debug column (as shown in Figure 6-42, 

double click reference tag AI00100001 connected to CSV pin in function block PID, and the 

real-time value of the reference tag is displayed in variable debug column). 

 

Figure 6-42 Variable debug bar displays real-time value 

6.5.4 Save the Real-Time Value of Function Block 

Select any function block and click “Save the Real-time Value of Function Block” button, dialog box 

for saving parameter will pop up. The real-time value of function block can be saved by this 

function, making it convenient for parameter upload. When uploading real-time data of function 

blocks, software record closes data at the point where data is uploaded and then upload them. 
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Figure 6-43 Parameter save 

 

As shown above, the change status of tag is shown in the first column of the parameter list. 

  shows the parameter real-time value has changed. 

  shows the parameter real-time value has not changed. 

 

Tips: 

 In debug state, Input/ Output of function block can be activated by right-click menu of 

the function block. 

 Parameters that can’t be modified in debug state can only be adjusted in function block 

parameter column in function block properties settings interface. 
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Section 7 Other Operations and Prompts 

7.1 Show Associated Program 

When editing the program, you can view the linked programs of tags to avoid duplicate tag 

assignment and other operations. The tag includes the datalink or instantiated function block tag in 

the program. 

1) Select the tag 

Select the tag in the programming area and select "Show Associated Program" in the 

right-click menu. 

2) View the result 

If the tag has associated programs, the "List of Associated Programs" will pop up, as 

shown in the figure below. 

Where, the data link is displayed as "Assignment"; the function block instance is 

displayed as "Instance"; the alias tag is displayed as "Alias". 

Click the program page on the list to open the associated program. 

 

 

Figure 7-1 Example of associated programs 
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Tip: 

If the configuration version of the program does not support "Show associated program" 

function, you need to select the user program in the navigation tree of VFExplorer and 

right-click "Update Tag Usage". 

 

 

7.2 Find and Replace 

VFFBDBuilder supports finding and replacing tag in the datalink or instantiated function block of 

current program, and the operation are describes as following. 

1) Select “Edit > Find/Replace” to popup dialog shown as below. 

 

  Figure 7-1 “Find/Replace” Dialog Box 

2) Configure the tag to be found and replaced in “Find” and “Replace”. 

Operation of configuring “Find” and “Replace” is: 

Input in the textbox or click  to select tag in the popup “CS Tag Selection” dialog box. 

3) Check “Match Case” by requirement. 

Check, the configured tags must match the tags in program with case matched. 

Otherwise, the tags can match without case matched. 

4) After configured “Find” and “Replace”, select operation button by requirement: 

 Find Next, tag will be found in program one by one, and click “Replace” to replace its 

content. 

 Replace All, all tags match the condition in the program will be replace in a batch. 

 Mark, the operation result will be shown in the output bar. 
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Tips: 

If the content found and replaced are both correct, the operation of “Replacing All” will be 

succeeded. Otherwise, the operation of “Replacing All” will be failed. 

7.3 Modify Basic Properties in Batch 

User can modify the description, tag group and tag level of complex function block in batch via the 

information bar. 

Steps to modify basic properties of function block in batch: 

1) Select the function block whose basic properties should be modified in batch in the 

edit area. 

2) Select View/ Information Bar in menu bar to pop up the “Information Bar” below. 

 

Figure 7-2 Modify function block properties in batch in information bar 

3) User can modify function block properties in batch in “Information Bar”: 

 After cancel the “Auto Sorting for Function Block”, user can right-click to change its 

execution sequence. 

 Right-click to pop up the function block properties dialog, in which user can change the 

function block properties. 

 Support copy and paste. 

 Support pasting contents in Excel for description, tag group and tag level of function 

block: normal format of tag group is “Tag Group N”. There is a space between “N” and 

“Tag Group”. Description of custom tag group should conform to this rule too.  

 
Tips: 

 Execution sequence and tag name of function block don’t support modification in 

batch. 

 Basic properties are unnecessary for normal function block. As the function block ADD 

shown in the figure above. So it is not editable. 

 

7.4 Object Movement and Object Zoom 

7.4.1 Object movement 

FBD programming software supports dragging function blocks, users can click the selected 
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function block with the mouse button pressed, release the mouse until it is dragged to required 

location, and the line is moved correspondingly. 

7.4.2 Object Zoom 

All diagram objects can be zoomed, and the zoom rate is 0.6~1.5, users can implement operation 

of Zoom in, Zoom out and recover to function blocks in work area by clicking corresponding icons 

in toolbar, please refer to Introductions to Toolbar Icon Functions for specific information. 

7.5 Print Properties settings 

FBD programming software supports the general functions of Print, Print preview, and page layout 

setting. In addition, print information of footers can also be set. Click the item of “Print page footer 

setting” in “file”, window of footer setting will pop up, as shown in Figure 7-3. 

 

Figure 7-3 Footer Setting 

Some specific information of configuration program (i.e. program function name, Designed, 

Reviewed, version and other information) can be set. Click the place corresponding to a certain 

item to implement setting, and select “Yes” to complete the setting. The printed footer is same as 

set. 

7.6 Diagram Settings  

The software can execute Diagram Settings. Select “File” and click “Page Settings” to pop up the 

following dialog. 
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Figure 7-4 Diagram Settings 

 Diagram: select the diagram size, Diagram 1#(S), Diagram 2#(M) or Diagram 3#(L) 

from the pull-down menu. 

 Orientation: select the diagram orientation, landscape or portrait.  

 Footer: select whether to enable the footer.  

The diagram setting will change the print effect. Different diagram settings will result in different 

print effects.    

7.7 View the Logic of Global Function Block 

Users can view the logic of global function block conveniently after invoking global function block. 

The view steps are: 

1. Select the global function block to be viewed in the edit area, right-click it and select 

“View Logic”.  

2. Pop up VFSTModule software, in which the global function block is shown. 

7.8 Import/ Export 

The import or export functions of FBD program can be achieved by this operation. 

Click File/ Export, dialog box of Save As will pop up, select save path and click Yes to save 

current FBD program (save in .fbdi form). 

Click File/ Import, dialog box of Open will pop up, select needed file (in .fbdi form) to import 

program saved in the file. 
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7.9 Supervision Parameter of Function Block Example Update 

When some parameter data of current advanced function block example is modified, users should 

save configuration to configuration server in configuration management software so that 

information of local configuration can be uploaded to server completely. 

Supervision parameter of function block example update includes: add function block tag, update 

supervision parameter of function block, etc. 

7.10 Delete 

All delete confirmation in FBD is No by default. 

7.11 Alarm Priority Setting 

The priority of alarm is arrayed at tag (or function block) level, the priorities of all alarm items within 

one tag or function block is consistent. Users can modify the priority of tag or function block, but 

can’t configure the priority of each alarm item of a tag or function block. 
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Section 8 Revision 

Table 8-1 Retrofit list of the version 

Document 
version 

Applicable software version Remarks  

V1.0 
(20230301) 

OMC High-performanceHMI 
V4.70.00.00 

First release 

V1.1 
(20230830) 

OMC High-performanceHMI 
V5.10.00.00-M 

Added illustration of "show associated program" function, 
cross-station datalink and ISCP datalink. 
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